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Precautions 

Important Safety Warnings 

[Power] 
 
 
 
 

Do not place or drop heavy or sharp-edged objects on power cord. A damaged cord 
can cause fire or electrical shock hazards. Regularly check power cord for 
excessive wear or damage to avoid possible fire / electrical hazards. 

 [Circuitry Access] 
 
 
 
 

Do not touch any parts / circuitry with a high heat factor. 
Capacitors can retain enough electric charge to cause mild to serious shock, even 
after power is disconnected. Capacitors associated with the power supply are 
especially hazardous. Avoid contact with any capacitors. 

 
 
 
 

Unit should not be operated or stored with cover, panels, and / or casing removed. 
Operating unit with circuitry exposed could result in electric shock / fire hazards or 
unit malfunction. 

[Potential Hazards] 
 
 
 
 

If abnormal smells or noises are noticed coming from the unit, turn power off 
immediately and disconnect power cord to avoid potentially hazardous conditions. If 
problems similar to above occur, contact authorized service representative before 
attempting to again operate unit. 

[Consumables] 
 
 
 
 

The consumables used in unit must be replaced periodically. For further details on 
which parts are consumables and when they should be replaced, refer to the 
specifications at the end of the Operation Manual. Since the service life of the 
consumables varies greatly depending on the environment in which they are used, 
they should be replaced at an early date. For details on replacing the consumables, 
contact your dealer. 

 

Caution 

Stop 

Hazard 

Stop 

Caution 



 

Upon Receipt 

Unpacking  
UFM-30DCC modules and their accessories are fully inspected and adjusted prior to shipment. 
Operation can be performed immediately upon completing all required connections and 
operational settings. 
 
Check your received items against the packing lists below.  
 

ITEM QTY REMARKS 

UFM-30DCC 1 set 
Front module 

Rear module 

Operation Manual 1 This manual 
 

Option 
ITEM QTY REMARKS 

UFM-3DCC2C 1 Dual channel option (Software program) 

UFM-3DCC3G 1 3G-SDI option 

DCC-OUA 1 Operation Unit (RS-422 type) 

DCC-NETOU 1 Operation Unit (Ethernet type) 

Control Cable 1 For DCC-OUA connection  (PC-2076-3) 

UFM-30CTL 1 UFM module used for WEB control and 
DCC-NETOU control 

 
The UFM-30DCC modules can be installed into the UF-106A, UF-106B, or UF-112 frame, but 
not into the UF-106.  
Up to four modules can be installed into the UF-106A (up to two modules for the UF-106APS). 
Up to six modules can be installed into the UF-106B (up to four modules for the UF-106BPS). 
 

IMPORTANT

The UFM-30DCC/UFM-3DCC2C modules can be installed into the below UF-106A slots. 
 Slots 2, 4, 5, 6 are available.  
 Slots 1 and 3 cannot be used. 

See the UF-106A Operation Manual for the slot numbers. 

 

DCC-OUA, DCC-NETOU or UFM-30CTL (WEB control) is required to control 
UFM-30DCC. The dedicated control cable (PC-2076-3) is needed for DCC-OUA. The 
UFM-30CTL is needed to connect DCC-NETOU.  

The UFM-30DCC cannot be controlled from DCC-OUA and DCC-NETOU at the same 
time. 

 

Before using the DCC-OUA, confirm that the version of your DCC-OUA is 2.00 or later and 
that the version of its operation manual is 2nd Edition or later. If using UFM-30DCC in Dual 
Channel mode, confirm that the version of your DCC-OUA is 3.00 or later and that the 
version of its operation manual is 3rd Edition or later. See "DCC-OUA Operation Manual" 
for details on verifying the version of the DCC-OUA. If the versions are different, please 
contact your dealer. 

Note that some functions cannot be controlled with DCC-OU. (See section 3-1-2.) 

 

Check 
Check to ensure no damage has occurred during shipment. If damage has occurred, or items 
are missing, inform your supplier immediately. 
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1. Prior to Starting 

1-1. Welcome 
Congratulations! By purchasing UFM-30DCC Digital Color Corrector you have entered the world 
of FOR-A and its many innovative products. Thank you for your patronage and we hope you will 
turn to FOR-A products again and again to satisfy your video and audio needs. 
FOR-A provides a wide range of products, from basic support units to complex system 
controllers, which have been increasingly joined by products for computer video based systems. 
Whatever your needs, talk to your FOR-A representative. We will do our best to be of continuing 
service to you. 
The UFM-30DCC is a plug-in module that can be installed into the UF-106A, UF-106B, or 
UF-112 frame.  

 

1-2. Features 
The UFM-30DCC is a module-type digital color corrector that can be mounted onto UF-112 
frames. It has been specially developed as an HD/SD-SDI digital color corrector using the latest 
digital technology. The UFM-30DCC has three types of controllers: Operation Unit, Web-based 
controller and Network Operation Unit. 

 

 6 HD/SD-format support 
 Standard configuration:  

2 inputs (menu selection), 1 color correction channel and 2 outputs 
 UFM-3DCC2C installed:  

2 inputs, 2 color correction channels and 2 outputs 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Three operation modes (menu selection) 
Single Channel mode: 1 CC channel, 2 outputs 
Dual Channel mode: 2 CC channels, 1 output for each (individual setting) (optional) 
Link mode:   2 CC channels, 1 output for each (same setting) (optional) 

 DCC-OUA control or Web browser control selectable (internal setting) 
 Comprehensive color correction tools 
 Process Amplifier 
 Color Correction (White, Black and Gamma) 

Three color correction modes (menu selection) 
-Balanced mode for color correction of GBR signals 
-Differential mode for color correction of GBR signals 
-Sepia mode for creating monotone images 

 Composite clip, YPbPr clip and GBR clip 
 Bypass function (with Web browser control) 
 H/V ancillary data pass or blank 

HD/SD-SDI IN1 
Serial to
Parallel

Select
2:1 

Serial to
Parallel

Parallel
to Serial

Color 
Corrector

HD/SD-SDI IN2 

HD/SD-SDI OUT 1 

HD/SD-SDI OUT 2 

RS-422 

Standard configuration （1-channel）

HD/SD-SDI OUT 2 

HD/SD-SDI IN1 
Serial to
Parallel

Color 
Corrector

 
2-channel

or 
Link

Serial to
Parallel

Parallel
to Serial

Parallel
to SerialHD/SD-SDI IN2 

HD/SD-SDI OUT1

RS-422 

UFM-3DCC2C installed （2-channel）
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2. Panel Descriptions 

2-1. Front Panel 
 
 
 
 
 
 
 
 
 

No. Name Description 

1 INPUT LED 
Lit: Input signal present (normal). 
Unlit: No input signal present. 

Indication depending on the operation mode. (See table below.)

2 POWER LED Lights up whenever power is applied to the unit. 

3 Up and down switch Allows you to move between menu items. (See section 3-5. 
“Menu Operation.”) 

4 LED display Displays menu items and parameters. 

5 Menu control button Allows you to move between menu items and input settings. 
(See section 3-5. “Menu Operation.”) 

6 UNITY/display 
switching button 

Allows you to change between the default and current settings.

Allows you to switch between full names and short descriptions 
while displaying the associated menu number and name. 

 INPUT LED indication 
Operation Mode LED Description 

Single Channel 
 mode 

Lit Input signal is present at the selected channel. 

Unlit Input signal is not present at the selected channel. 

Dual Channel 
 mode 

Lit Input signal is present at either one or both channels 1 and 2. 

Unlit Input signal is not present at either channel 1 or 2. 

Link mode 
Lit Input signal is present at both channels 1 and 2. 

Unlit Input signal is not present at either one or both channels 1 and 2.

 
 

2-2. Rear Panel 
 
 
 
 
 
 
 
 
 

No. Name Description 

1 HD/SD-SDI IN 1, 2 Used to input HD/SD-SDI signals. 

2 HD/SD-SDI OUT 1, 2 Used to output HD/SD-SDI signals. 

3 REMOTE Use to connect to the DCC-OUA. 

5 

6 
1 

2 

3 4 

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT

(3)

S
/N

o
.

UFM-30DCCHD/SD-SDI OUT

21

HD/SD-SDI IN

1 2

REMOTE

(1) (2)
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3. Connection 
The UFM-30DCC modules can be installed into the UF-106A, UF-106B, or UF-112 frame. Refer to 
the figure below and connect the UFM-30DCC to other devices. See the respective operation 
manuals for details on how to install UFM-30DCC modules into the UF-106A, UF-106B, or UF-112. 
 

IMPORTANT

Please turn off the power of all devices before connection. 

 
 

3-1. Connecting to DCC-OUA 
To connect between the UFM-30DCC and DCC-OUA, the supplied cable (PC-2076-3) is 
required. Plug the cable to the REMOTE connector on the UFM-30DCC. See "DCC-OUA 
Operation Manual" (2nd Edition or later) for more details. 
 
 Ex. UF-112 rear panel: UFM-30DCC 

 Standard Configuration (with 1 Color Correction Channel) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Optional Configuration (with 2 Color Correction Channels) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

UF-112 

R
A

T
IN

G
 L

A
B

E
L

G
E

N
L

O
C

K
 I

N
A

L
A

R
M

A
C

1
0

0-
2

4
0V

 ~
 5

0
/6

0H
z 

IN

F
A

N
A

L
M

UFM-30DCC

HD/SD OUT1 (Channel 1 Out) 

HD/SD OUT2 (Channel 2 Out) 

HD/SD SDI IN2

HD/SD SDI IN1

S
/N

o
.

UFM-30DCCHD/SD-SDI OUT

21

HD/SD-SDI IN

1 2

REMOTE

Supplied cable

RATING LABEL
OFF

PU SH

ESU
FPOWER

ON

TO MU4TO MU3TO MU2TO MU1

AC100-117V ~ 50/60Hz IN

DCC-OUA 

UF-112 

R
A

T
IN

G
 L

A
B

E
L

G
E

N
L

O
C

K
 I

N
A

L
A

R
M

A
C

1
0

0-
2

4
0V

 ~
 5

0
/6

0H
z 

IN

F
A

N
A

L
M

UFM-30DCC

HD/SD OUT 1 

HD/SD OUT 2 

HD/SD SDI IN2

HD/SD SDI IN1

RATING LABEL
OFF

PU SH

ESUFPOWER

ON

TO MU4TO MU3TO MU2TO MU1

AC100-117V ~ 50/60Hz IN

S
/N

o
.

UFM-30DCCHD/SD-SDI OUT

21

HD/SD-SDI IN

1 2

REMOTE

Supplied cable

DCC-OUA 
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3-1-1. REMOTE Connector 

 REMOTE Connector 
9-pin, D-sub female (inch screw threads used) 

 
 
 
 
 
 

 REMOTE connector pin assignment (9-pin, D-sub female) 
Pin No. Signal Description 

1 Reserved Not used 

2 TX (-) TRANSMIT- 

3 RX (+) RECEIVE+ 

4 - - 

5 - - 

6 - - 

7 TX (+) TRANSMIT+ 

8 RX (-) RECEIVE- 

9 FG Frame ground 

 
 

3-1-2. Using DCC-OU (Previous Model) 

If the DCC-OU is used, the following functions are not available. 
 
-SPLIT setting 
-Gamma curve setting 
-GBR clip setting 
-Composite clip setting 
 

DCC-OU can control the UFM-30DCC only in Single Channel mode. 
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3-2. Connecting to a WEB Browser 
To connect a WEB browser on a computer to a UFM-30DCC on a UFM frame, connect the 
computer to a UFM-30CTL, which should be mounted on the same UFM frame, via Ethernet. 
See "UFM-30CTL Operation Manual" for connecting UFM-30CTL and the computer. 
 

 Basic System (with 1 Color Correction Channel) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Expanded System (with 2 Color Correction Channels) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

UFM-30CTL 

HD/SD OUT1 (Channel1 Out)

HD/SD OUT2 (Channel2 Out)

HD/SD SDI IN2 

HD/SD SDI IN1 

R
A

T
IN

G
 L
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E
L

G
E

N
L

O
C

K
 I
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0
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0

0B
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E
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N

R
S
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1
2

S
/N

o
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UFM-30DCCHD/SD-SDI OUT

21

HD/SD-SDI IN

1 2

REMOTE

UF-112 
UFM-30DCC 

Ethernet 

Hub
PC 

UFM-30CTL 

HD/SD OUT 1

HD/SD OUT 2
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HD/SD SDI IN1 

R
A

T
IN

G
 L

A
B

E
L

G
E

N
L

O
C

K
 I

N
A

L
A

R
M

A
C

1
0

0-
2

4
0V

 ~
 5

0
/6

0H
z 

IN

F
A

N
A

L
M

S/No.

U
F

M
-3

0
C

T
L

(1
0

/1
0

0B
A

S
E

-T
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N

R
S
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2

2

1
2

S
/N

o
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UFM-30DCCHD/SD-SDI OUT

21

HD/SD-SDI IN

1 2

REMOTE

PC 
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UFM-30DCC 

Ethernet 

Hub
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3-3. Connecting to DCC-NETOU 
To connect DCC-NETOU to a UFM-30DCC on a UFM frame, connect DCC-NETOU and a 
UFM-30CTL, which should be mounted on the same UFM frame, via Ethernet. See 
"DCC-NETOU Operation Manual" for connecting the UFM-30CTL and DCC-NETOU. 
 
 Ex. UF-112 rear panel: UFM-30DCC and UFM30CTL 

 Basic System (with 1 Color Correction Channel) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Expanded System (with 2 Color Correction Channels) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

UFM-30CTL 

HD/SD OUT1 （Channel 1 Out）

HD/SD OUT2 （Channel 2 Out）

HD/SD SDI IN 2 

HD/SD SDI IN 1 

R
A

T
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E
L

G
E
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L
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R
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2

S
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o
.

UFM-30DCCHD/SD-SDI OUT
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HD/SD-SDI IN

1 2

REMOTE
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UFM-30DCC 

Ethernet 
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OFF
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POWER AC100-240V 50/60Hz IN

(10/100BA SE-T )

RATING LABEL

DCC-NETOU PC 

UFM-30CTL 

HD/SD OUT 1

HD/SD OUT 2

HD/SD SDI IN 2 

HD/SD SDI IN 1 

R
A

T
IN

G
 L

A
B

E
L

G
E

N
L

O
C

K
 I

N
A

L
A

R
M

A
C

1
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4
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0
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M
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3-4. Power On 

3-4-1. UF-106A or UF-106B 

 Ex. UF-106B 
1) Loosen and pull out the screw knobs on both sides to open the front panel of the UF-106B. 

 
 
 
 
 
 
 

2) Turn the power switch on. 
 
 
 
 
 

 

3-4-2. UF-112  

1) Loosen and pull out the screw knobs on both sides to open the front panel of the UF-112. 
 
 
 
 
 
 
 
 
 
 
 
 

2) Make sure all devices are properly connected and turn on the power of the universal 
frame. After startup, “UFM30DCC” appears on the front panel. If a video signal is input 
and power is applied, the INPUT and POWER indicators light up green. 

 
 
 
 
 
 
 
 
 
 
 
 
 

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUTINPUT LED 

POWER LED 

U F M 3 0 D C C

OFF

POWER

TEMP

FAN

ALARM

DC
POWER

POWER

GENLOCK
INON

POWER switch 

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT

UNIVERSAL FRAME

ALARM

POWER 2

ALARM

POWER 1

FAN

TEMP TEMP

GENLOCK IN

POWER POWER

GENLOCK IN

FAN

DC POW DC POW

UF-112

POWER
FAN TEMP DC POW

ALARM
GENLK IN

POWER

POWER 1 POWER 2GENLK IN
ALARM

DC POWTEMPFAN
(OPTION)

UF-106B
UNIVERSAL FRAME

ON

POWER

ALARM

REF
IN

DC
POWER

TEMP

OFF

POWER FAN

ON

POWER

ALARM

REF
IN

DC
POWER

TEMP

OFF

POWER FAN

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT
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3-5. Menu Operation 
1) Turn the menu control button to display the desired item.  
 
 
 
 
 
 

I N S E L >

 
2) Press the menu control button. The value of the item is displayed. 
 
 
 
 
 
 

S D I I n 1

 
3) Turn the menu control button to select the value. 
 
4) Press the menu control button to apply the setting. 
 
 
 
 
 
 

I N S E L >

 
Repeat the steps 1) -4) to adjust all necessary settings. 
 

 To Move Between Menu Categories 
Move the switch up and down to move between menu categories such as System Setup, 
System Status and Module Information. 

 To Display Settings in a Category 
Pressing the UNITY button while displaying a category name scrolls the screen to the side 
and displays the category settings. 

 To Return a Parameter to Default Setting 
Pressing the UNITY button while displaying an item resets the setting to its default value.  

 To Undo Changes 
Moving the switch up after changing a setting value (and before pressing the menu control 
button) undoes the value. If you wish to change the value again after undoing the setting, 
move the switch down. Pressing the menu control button applies the value shown in the 
menu display. 
 
 

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT
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3-6. DCC-OUA Control and WEB Browser Control 
There are two methods for controlling the UFM-30DCC: using DCC-OUA and using a computer 
web browser or DCC-NETOU via LAN.  To switch the control method, change the dipswitch and 
the jumper settings on the UFM-30DCC card. The default control method uses DCC-OUA. (See 
6. "Internal Settings.") 
Different UFM-30DCC front panel menu settings are available between the DCC-OUA control 
and web browser control. See the next page for details. 
 
 

3-6-1. DCC-OUA Control (Ver. 2.00 or later)  

Note that the VIDEO menus including Process Amp, Color Correction, Split Mode and Video 
Clip cannot be set or displayed on the UFM-30DCC front panel. They are set in the 
DCC-OUA. However, the input signal can be selected only on the UFM-30DCC. (See the 
"DCC-OUA Operation Manual" for UFM-30DCC operation on the DCC-OUA.) 

 
 
 
 
 
 
 
 
 
 
 
 

3-6-2. WEB Browser Control 

Similar menu items can be set both on the UFM-30DCC and the web browser  
 
 
 
 
 
 
 
 
 
 
 
 

UFM frame

UFM-30DCC

DCC-OUA（V2.00 and later） VIDEO menus 
UTILITY menu 
Bypass/Operate setting 

SYSTEM menu 
STATUS menu 

UFM frame

UFM-30DCC

WEB
 browser 

VIDEO menus 
SYSTEM menu 
UTILITY menu 
STATUS menu 

VIDEO menus 
SYSTEM menu 
UTILITY menu 
STATUS menu UFM-30CTL
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3-6-3. Differences between DCC-OUA Control and WEB Control 

When controlling a UFM-30DCC with DCC-OUA, color correction settings can be set only on 
the DCC-OUA and system settings only on the UFM-30DCC. When controlling with a web 
browser, essentially the same control can be achieved both in the UFM-30DCC and web 
browser. The table below shows the available features for each controller. 
 

Control method UFM-30DCC with DCC-OUA UFM-30DCC with Web browser and/or 
DCC-NETOU 

Controller 

Feature 
UFM-30DCC 
(Front panel) DCC-OUA UFM-30DCC 

(Front panel) 
WEB 

browser 
DCC- 

NETOU 

Input Select ○ × ○ ○ ○ 

Bypass/Operate × ○ ○ ○ ○ 

Loss Mode ○ × ○ ○ × 

Back Color ○ × ○ ○ × 

H/V Ancillary Mode ○ × ○ ○ × 

Output Delay ○ × ○ ○ × 

Test Signal ○ × ○ ○ × 

Operation Mode 
(Single/Dual/Link) ○ × ○ ○ × 

      

Panel Lock ○ × ○ × × 

Start Up Event Load × × ○ ○ × 

Auto Event Load × × ○ ○ × 

Event Load/Event Save × ○ ○ ○ ○ 

Clip Event Load/Clip Event 
Save × ○ × × × 

Save File × × × ○ × 

Restore × × × ○ × 

      

Color Corrector selection  
(Channel selection) ○ ○ ○ ○ ○ 

Proc Amp × ○ ○ ○ ○ 

Color Correction × ○ ○ ○ ○ 

Split mode selection × ○ ○ ○ ○ 

Video Clip × ○ ○ ○ ○ 

○: Available 
×: Not available 
 
See the following sections for the available menu items on the UFM-30DCC front panel. 
See "DCC-OUA Operation Manual" for the menu items available on DCC-OUA units. 
See "UFM-30CTL Operation Manual" for the menu items available on web browsers. 
 

When controlling UFM-30DCC from DCC-NETOU units, available menu items on the 
UFM-30DCC front panel are the same as those when controlling from web browsers. 

See "DCC-NETOU Operation Manual" for more details. 
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4. Controlling with DCC-OUA 

4-1. Menu List on UFM-30DCC Front Panel 

4-1-1. 1-Channel Color Corrector System 

If In 1 is selected: 
 
 
 
 
 
 

If In 2 is selected: 
 
 
 
 
 
 
 
 

4-1-1-1. Standard Configuration (1-Channel) Menu 

Category Description 

SYSTEM Allows you to set system settings such as input signal selection, loss mode 
selection and pass through of ancillary data. 

STATUS Displays the video signal status and module information. 

 

Category 
Menu 

Refer 
to No. Item (full name) Short 

description 

SYSTEM 1  System Setup System 4-2-2 

  1-1 

1-2 

1-3 

1-4 

1-5 

1-6 

1-9 

1-11

1-12

Input Select>  

Loss Mode> 

Back Color> 

H Ancillary Mode 

V Ancillary Mode 

Output Delay>  

Test Signal> 

Front Brightness> 

Panel Lock> 

IN SEL> 

LossMOD> 

BColor> 

H ANCI> 

V ANCI> 

Out DLY> 

TESTSIG> 

Bright> 

Lock > 

 

 

STATUS 2  System Status SYSTMSTS 4-2-3 

  2-1 

2-2 

2-3 

Selected SDI Input>  

SDI IN1 Format> 

SDI IN2 Format> 

SEL IN> 

IN1 STS> 

IN2 STS> 

 

 3  Module Information MDL INFO 4-2-4 

  3-1 

3-2 

3-3 

3-4 

3-5 

3-6 

External Control Mode> 

Version Info> 

FPGA Version Info> 

UFM-3DCC2C Option Info> 

UFM-3DCCMF Option Info> 

UFM-3DCC3G Option Info> 

CTL Mod> 

Version> 

FPGA> 

Dual Ch> 

Multi> 

3G Op> 

 

UFM-30DCC

In 1 

In 2 

Color Corrector 1
Setting 1 

Out 1 

Out 2 

UFM-30DCC

In 1 

In 2 

Color Corrector 1
Setting 1 

Out 1 

Out 2 
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4-1-2. 2-Channel Color Corrector System (UFM-3DCC2C Option) 

4-1-2-1. Selecting Mode 

In the 2-Channel system, three modes are available: Single Channel mode, Dual 
Channel mode, where two inputs are separately processed with different settings, and 
Link mode, where two inputs are separately processed with the same settings. 
 
1) Turn the menu control button to display OP Mode>. 
 
 
 
 
 

O P M o d e >

 
2) Press the menu control button. The default setting is Dual Channel mode (Dual). 
 
 
 
 
 

D u a l  

 
3) Turn the menu control button to select an operation mode from Single, Dual and Link. 

Press the menu control button. 
 
 
 
 
 
 

L i n k  >

 

IMPORTANT

Single Channel mode, Link mode and "Setting1" of Dual Channel mode share the 
same set of color corrector settings. Therefore, if some items are changed before 
switching the operation mode, the same changes apply in the new operation mode. 
If you wish to use specific settings in each mode, save them to an event memory 
and load them from it.  

 
 

4-1-2-2. Single Channel Mode Menu 

The Single Channel mode menu in the 2-Channel Color Corrector system is similar to 
the 1-Channel Color Corrector system menu. The only difference is that the 2-Channel 
system has 1-10 Operation Mode in the menu. See 4-1-1."1-Channel Color Corrector 
System" for menu details. 
 
 

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT

UFM-30DCC

UFM-30DCC
(PUSH)

UNITYPOWER

INPUT
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4-1-2-3. Dual Channel Mode Menu 

In Dual Channel mode two color correctors can process signals under the different 
settings. Before using a color corrector, select the color correction channel to Select 
Color Corrector 1 or 2. 

 
 
 
 
 
 
 
 
 
 

Category Description 

DUAL Allows you to select a color correction channel (color corrector). 

SYSTEM Allows you to set system settings such as input signal selection, loss mode 
selection and pass through of ancillary data.. 

STATUS Displays the video signal status and module information. 

 

Category 
Menu Refer 

to No. Item (full name) Short description

DUAL -  Select Color Corrector 1 or 2>  Sel CC> 4-2-1 

SYSTEM 1  System Setup System 4-2-2 

  1-2 

1-3 

1-4 

1-5 

1-6 

1-9 

1-10

1-11

1-12

1-13

Loss Mode> 

Back Color> 

H Ancillary Mode 

V Ancillary Mode 

Output Delay>  

Test Signal> 

Operation Mode> 

Front Brightness> 

Panel Lock> 

Input Status Display Set>  

LossMOD> 

BColor> 

H ANCI> 

V ANCI> 

Out DLY> 

TESTSIG> 

OP Mode> 

Bright> 

Lock > 

IN DSP> 

 

 

STATUS 2  System Status SYSTMSTS 4-2-3 

  2-2 

2-3 

SDI IN1 Format> 

SDI IN2 Format> 

IN1 STS> 

IN2 STS> 

 

 3  Module Information MDL INFO 4-2-4 

  3-1 

3-2 

3-3 

3-4 

3-5 

3-6 

External Control Mode> 

Version Info> 

FPGA Version Info> 

UFM-3DCC2C Option Info> 

UFM-3DCCMF Option Info> 

UFM-3DCC3G Option Info> 

CTL Mod> 

Version> 

FPGA> 

Dual Ch> 

Multi> 

3G Op> 

 

 

UFM-30DCC

Color Corrector 2
Setting 2 

Color Corrector 1
Setting 1 In 1 

In 2 

Out 1 

Out 2 
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4-1-2-4. Link Mode Menu 

In Link mode, two color correctors share the same settings. 
 
 
 
 
 
 
 
 
 
 

Category Description 

SYSTEM Allows you to set system settings such as input signal selection, loss mode 
selection and pass through of ancillary data. 

STATUS Displays the video signal status and module information. 

 

Category 
Menu Refer 

to No. Item (full name) Short description 

SYSTEM 1  System Setup System 4-2-2 

  1-2 

1-3 

1-4 

1-5 

1-7 

1-8 

1-9 

1-10 

1-11 

1-12 

Loss Mode> 

Back Color> 

H Ancillary Mode 

V Ancillary Mode 

Output Delay1> 

Output Delay2> 

Test Signal> 

Operation Mode> 

Front Brightness> 

Panel Lock> 

LossMOD> 

BColor> 

H ANCI> 

V ANCI> 

Out DL1> 

Out DL2> 

TESTSIG> 

OP Mode> 

Bright> 

Lock > 

 

 

STATUS 2  System Status SYSTMSTS 4-2-3 

  2-2 

2-3 

SDI IN1 Format> 

SDI IN2 Format> 

IN1 STS> 

IN2 STS> 

 

 3  Module Information MDL INFO 4-2-4 

  3-1 

3-2 

3-3 

3-4 

3-5 

3-6 

External Control Mode> 

Version Info> 

FPGA Version Info> 

UFM-3DCC2C Option Info> 

UFM-3DCCMF Option Info> 

UFM-3DCC3G Option Info> 

CTL Mod> 

Version> 

FPGA> 

Dual Ch> 

Multi> 

3G Op> 

 

 

UFM-30DCC

Color Corrector 2
Setting 1 

Color Corrector 1
Setting 1 In 1 

In 2 

Out 1

Out 2
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4-2. Menu Details (UFM-30DCC Front Panel) 

4-2-1. Color Corrector (Channel) Selection 

Mode Item Default Setting Description 

Dual Select Color Corrector 1 or 2> Correct1 Correct1,
Correct2 

Allows you to select a color 
corrector (channel). 

 
 

4-2-2. System Setting 

Menu 
Default Setting 

Range Description 
No. Mode Item 

1 System Setup 

1-1 Single Input Select > SDI In1 SDI In1, 
SDI In2 

Allows you to select SDI In 
signal. 

1-2 
Single 
Dual 
Link 

Loss Mode > BackCOL
BackCOL,
ColorBar, 
Disable 

Allows you to specify the action 
to be taken when no signal is 
present. 

1-3 
Single 
Dual 
Link 

Back Color> Black 
Black, 
Gray,  
Blue 

Allows you to select a 
background display color when 
no signal is present. 

1-4 
Single 
Dual 
Link 

H Ancillary Mode> Through Through, 
Delete 

Through: Passes through 
ancillary data without 
processing.  

Delete: Deletes all ancillary 
data. 1-5 

Single 
Dual 
Link 

V Ancillary Mode> Through Through, 
Delete 

1-6 Single 
Dual Output Delay> --- (*1) 

Allows you to set the output 
delay in the range from 
minimum delay to approx. 1H. 
The setting range varies 
depending on the format.  

The setting automatically 
returns to the minimum delay 
when the input signal format is 
changed.  

1-7 Link Output Delay1> --- (*1) 

Allows you to set the output 
delay for Out1 in the range from 
minimum delay to approx. 1H. 
The setting range varies 
depending on the format.  

The setting automatically 
returns to the minimum delay 
when the input signal format is 
changed.  

1-8 Link Output Delay2> --- (*1) 

Allows you to set the output 
delay for Out2 in the range from 
minimum delay to approx. 1H. 
The setting range varies 
depending on the format.  

The setting automatically 
returns to the minimum delay 
when the input signal format is 
changed.  

1-9 
Single 
Dual 
Link 

Test Signal> Off 

Off, 
Full CB, 

SMPTE CB,
RAMP 

Allows you to output a test 
signal. The test signal appears 
on the full screen regardless of 
the VIDEO menu setting. 
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1-10 
Single 
Dual 
Link 

Operation Mode> Dual 
Single, 
Dual, 
Link 

Allows you to select an 
operation mode for 
UFM-30DCC. 

Single: Single Channel mode 
Dual: Dual Channel mode 
Link: Link mode 

1-11 
Single 
Dual 
Link 

Front Brightness> 50% 

25%, 
50%, 
75%, 
100%, 

Allows you to select the 
brightness of the front panel 
display. 

1-12 
Single 
Dual 
Link 

Panel Lock> Operate Operate, 
Lock 

Setting to Lock inhibits the 
operation using the front panel. 
Hold down the menu control 
button for about 2 seconds to 
release (Operate) Panel Lock.

1-13 Dual Input Status 
Display Set> 1min 

Off, 
1min, 
5min 

Allows you to set the time until 
the input signal status is 
automatically displayed while 
no operations are being 
performed. (*3) 

Off: No display 
1min: Displays the input status 
when no operation is performed 
within 1 minute. 
5min: Displays the input status 
when no operation is performed 
within 5 minutes. 

 
(*1) Setting Range for Output Delay 

System Format Output Delay setting range 

525/60 200CLK to 1716CLK 

1080/59.94i 140CLK to 2200CLK 

720/59.94p 140CLK to 1650CLK 

625/50 200CLK to 1728CLK 

1080/50i 140CLK to 2640CLK 

720/50p 140CLK to 1980CLK 

 
(*2) Operation Mode 

The Operation Mode is not displayed in the 1-Channel system but it is displayed in the 
2-Channel system (option installed) in all operation modes including Single Channel mode. 
Single Channel mode, Link mode and "Setting1" of Dual Channel mode share the same 
set of color corrector settings. Therefore, if some items are changed before switching the 
operation mode, the same changes apply in the new operation mode. If you wish to use 
specific settings in each mode, save them to and load them from an event memory.  

 
(*3) Input Status Display Set 

Input Status Display Set allows you to display the input signal status using ○ (present) and 
× (not present) automatically when no operation is performed within 1 or 5 minutes. The 
display example below shows that In1 is present but In2 is not present. 
 
Display Example) IN1○IN2× 
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4-2-3. System Status (Display Only) 

Menu 
Description 

No. Mode Item 

2 System Setup 

2-1 Single Selected SDI Input > Displays the currently selected input signal.  

2-2 Single 
Dual 
Link 

SDI IN1 Format > Displays the video signal format input to SDI IN1. 

2-3 Single 
Dual 
Link 

SDI IN2 Format > Displays the video signal format input to SDI IN2. 

 
 

4-2-4. Module Information (Display Only) 

Menu 
Description 

No. Item 

3 Module Information 

3-1 
External Control Mode> 

Displays the current external control mode. "OU 
Mode" is displayded while controlling with 
DCC-OUA. 

3-2 Version> Displays the firmware version. 

3-3 FPGA> Displays the FPGA version. 

3-4 UFM-3DCC2C Option Info> Displays the dual channel option status. 

Install: The dual channel option is installed. 
None: The dual channel option is not installed. 

3-5 UFM-3DCCMF Option Info> Displays the multi-format option status. 

Install: The multi-format option is installed. 
None: The multi-format option is not installed. 

* "Install" is shown when a 3G-SDI option is 
installed. 

3-6 UFM-3DCC3G Option Info> Displays the 3G-SDI option status. 

Install: The 3G-SDI option is installed. 
None: The 3G-SDI option is not installed. 

 

NOTE

About automatic saving 

The UFM-30DCC automatically saves the most recent settings. After changing settings, 
wait at least 3 seconds before powering off. Otherwise, the settings may not save. 
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5. Controlling with WEB Browser 
To control UFM-30DCC with a web browser and/or DCC-NETOU, install the UFM-30DCC and a 
UFM-30CTL on the same UFM frame and connect the UFM-30CTL and a computer and/or 
DCC-NETOU via LAN. In addition, control system should be changed from DCC-OUA to 
LAN-based (WEB) using DIP switch and jumper settings on the UFM-30DCC card. (See section 6. 
"Internal Settings".) While controlling UFM-30DCC from a web browser, the UFM-30DCC can be 
also controlled locally on the front panel, but not from DCC-OUA units. 
 

See "UFM-30CTL Operation Manual" for details on operating the UFM-30DCC in the web 
browser. 

When controlling UFM-30DCC from DCC-NETOU units, available menu items on the 
UFM-30DCC front panel are the same as those when controlling from web browsers. See 
"DCC-NETOU Operation Manual" for more details. 

 
 

5-1. Menu List on UFM-30DCC Front Panel 

5-1-1. 1-Channel Color Corrector System 

If In 1 is selected: 
 
 
 
 
 
 
 
 

If In 2 is selected: 
 
 
 
 
 
 
 
 

5-1-1-1. Standard Configuration (1-Channel) Menu 

Category Description 

Video Process AMP Allows you to set the Proc Amp function. 

Color Correction Allows you to set the Color Correction function. 

Video Clip Allows you to set the Video Clip function. 

SYSTEM Allows you to set system settings such as input signal selection. 

UTILITY Allows you to save and load events and make front panel settings. 

STATUS Displays the video signal status and module information. 

 

IMPORTANT

Note that if Bypass/Operate (4-02 in the table below) is set to Bypass, all items in the 
VIDEO menu cannot be set. Change Bypass/Operate to Operate and then set 
these settings. 

 

UFM-30DCC

In1

In 2

Color Corrector 1
Setting 1 

Out 1

Out 2

UFM-30DCC

In 1

In 2

Color Corrector 1
Setting 1 

Out 1

Out 2
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 Video Process AMP menu 
Menu Refer 

to No. Correction Mode setting (*1) Item (full name) Short description

1   Video Process AMP Process 5-2-2

 1-01 DIF, BAL, SEPIA Video Level >  VID LVL>  

 1-02 DIF, BAL, SEPIA Y Level >  Y Level>  

 1-03 DIF, BAL Chroma Level >  C Level>  

 1-04 DIF, BAL, SEPIA Setup/Black Level >  Blk LVL>  

 1-05 DIF, BAL Hue >  Hue >  
(*1) Chroma Level and Hue cannot be set when 2-02 Correction Mode is set to SEPIA. 

 

 Color Correction menu 
Menu Refer 

to No. Correction Mode setting (*1) Item (full name) Short description

2   Color Correction Correct 5-2-3 

 2-01 DIF, BAL, SEPIA Split Mode >  Split>  

 2-02 -- Correction Mode >  CRT MOD>  

 2-03 DIF, BAL Group Adjustment >  GRP ADJ>  

 2-04 DIF, BAL White Level Red >  White R>  

 2-05 DIF, BAL White Level Green >  White G>  

 2-06 DIF, BAL White Level Blue >  White B>  

 2-07 DIF, BAL Black Level Red >  Black R>  

 2-08 DIF, BAL Black Level Green >  Black G>  

 2-09 DIF, BAL Black Level Blue >  Black B>  

 2-10 DIF, BAL, SEPIA Gamma Curve >  Gamma >  

 2-11 DIF, BAL Gamma Level Red >  Gamma R>  

 2-12 DIF, BAL, SEPIA Gamma Level Green >  Gamma G>  

 2-13 DIF, BAL Gamma Level Blue >  Gamma B>  

 2-14 SEPIA Sepia Level > Sepia L>  

 2-15 SEPIA Sepia Color >  Sepia C>  
(*1)  The menu items vary by the mode setting in 2-02 Correction Mode. 

 

 Video Clip menu 
Menu Refer 

to No. Video Clip Mode setting (*1) Item (full name) Short description

3   Video Clip VID Clip 5-2-4 

 3-01 --- Video Clip Mode>  CLP MOD>  

 3-02 YPbPr Y White Clip> Y White>  

 3-03 YPbPr Y Black Clip>  Y Black>  

 3-04 YPbPr Chroma Clip>  C Clip>  

 3-05 GBR GBR White Clip> GBR WHT>  

 3-06 GBR GBR Black Clip>  GBR BLK>  

 3-07 VBS Composite White Clip> VBS WHT>  

 3-08 VBS Composite Black Clip>  VBS BLK>  
(*1) The menu items vary by the mode setting in 3-01 Video Clip Mode. 
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 SYSTEM menu 
Menu Refer 

to No. Item (full name) Short description 

4  System Setting System 5-2-5 

 4-01 Input Select>  IN SEL>  

 4-02 Bypass/Operate> By-Op>  

 4-03 Loss Mode> LossMOD>  

 4-04 Back Color> BColor>  

 4-05 H Ancillary Mode> H ANCI>  

 4-06 V Ancillary Mode> V ANCI>  

 4-07 Output Delay>  Out DLY>  

 4-10 Test Signal Test SIG  

 

 UTILITY menu 
Menu Refer 

to No. Item (full name) Short description 

5  Event Memory EventMEM 5-2-6 

 5-01 Start Up Event Load> (*1)(*2) STUP EL>  

 5-02 Auto Event Load> (*1) Auto EL>  

 5-03 Event Load> (*1)(*2) Ev Load>  

 5-04 Event Save> (*1)(*2) Ev Save>  

6  Front Panel Setting PanelSET 5-2-7 

 6-01 Front Brightness> Bright>  

 6-02 Panel Lock> Lock>  
(*1) This item cannot be set if 4-02 Bypass/Operate is set to Bypass. In such case, an error message  

In Bypass, it doesn't operate appears. 

(*2) Events cannot be loaded or saved if Auto Event Load is set t o Enable. If UFM-30DCC is powered 
off and on again while Auto Event Load is set to Enable, priority is given to Auto Event Load over 
Start Up Event Load. If Auto Event Load is set to Enable, Start Up Event Load cannot be 
changed and the error message Auto Event Load Enable! appears. 

 

 STATUS menu 
Menu Refer 

to No. Item (full name) Short description 

7  System Status SYSTMSTS 5-2-8

 7-01 Selected SDI Input> SEL IN>  

 7-02 SDI IN1 Format> IN1 STS>  

 7-03 SDI IN2 Format> IN2 STS>  

8  Module Information MDL INFO 5-2-9

 8-01 Slot Number> Slot NO>  

 8-02 External Control Mode> CTL Mod>  

 8-03 Version Info> Version>  

 8-04 FPGA Version Info> FPGA>  

 8-05 UFM-3DCC2C Option Info> Dual Ch>  

 8-06 UFM-3DCCMF Option Info> Multi>  

 8-07 UFM-3DCC3G Option Info> 3G Op>  
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5-1-2. 2-Channel Color Corrector System (UFM-3DCC2C Option) 

5-1-2-1. Selecting Mode 

In a 2-Channel system, three modes are available: Single Channel mode, Dual Channel 
mode, where two inputs are separately processed with different settings, and Link mode, 
where two inputs with the same settings are separately processed. Select the operation 
mode in "4-11 Operation Mode." 
 

IMPORTANT

Single Channel mode, Link mode and "Setting1" of Dual Channel mode share the 
same set of color corrector settings. Therefore, if some items are changed before 
switching the operation mode, the same changes apply in the new operation mode. If 
you wish to use specific settings in each mode, save them to and load them from an 
event memory.  

 
 

5-1-2-2. Single Channel Mode Menu 

The Single Channel mode menu in the 2-Channel Color Corrector system is essentially 
the same as the 1-Channel Color Corrector system menu. The only difference is that the 
2-Channel system has 1-10 Operation Mode in the menu. See 5-1-1."1-Channel Color 
Corrector System" for menu details. 
 
 

5-1-2-3. Dual Channel Mode Menu 

In Dual Channel mode two color correctors can process signals under different settings. 
Before using a color corrector, select the color correction channel at Select Color 
Corrector 1 or 2. 
 
 

 
 
 
 
 
 
 

Category Description 

DUAL Allows you to select a color correction channel (color corrector). 

Video Process AMP Allows you to set the Proc Amp function. 

Color Correction Allows you to set the Color Correction function. 

Video Clip Allows you to set the Video Clip function. 

SYSTEM Allows you to set system settings such as input signal selection. 

UTILITY Allows you to save and load events and adjust front panel settings.

STATUS Displays video signal status and module information. 

 

Category 
 Menu Refer 

to No. Item (full name) Short description

DUAL - Select Color Corrector1 or 2> Sel CC> 5-2-1

 

The VIDEO menu items are the same in all operation modes. See "5-1-1. "1-Channel 
Color Corrector System" for the menu details. 

UFM-30DCC

Color Corrector 2
Setting 2 

Color Corrector 1
Setting 1 In 1 

In 2 

Out 1 

Out 2 
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 SYSTEM Menu 
 Menu Refer 

to No. Item (full name) Short description 

4  System Setting System 5-2-5 

 4-02 Bypass/Operate> By-Op>  

 4-03 Loss Mode> LossMOD>  

 4-04 Back Color> BColor>  

 4-05 H Ancillary Mode> H ANCI>  

 4-06 V Ancillary Mode> V ANCI>  

 4-07 Output Delay>  Out DLY>  

 4-10 Test Signal Test SIG  

 4-11 Operation Mode> OP Mode>  

 

 UTILITY Menu 
Menu Refer 

to No. Item (full name) Short description 

5  Event Memory EventMEM 5-2-6 

 5-01 Start Up Event Load> (*1)(*2) STUP EL>  

 5-02 Auto Event Load> (*1) Auto EL>  

 5-03 Event Load> (*1)(*2) Ev Load>  

 5-04 Event Save> (*1)(*2) Ev Save>  

6  Front Panel Setting PanelSET 5-2-7 

 6-01 Front Brightness> Bright>  

 6-02 Panel Lock> Lock>  

 6-03 Input Status Display Set> IN DSP>  
(*1) This item cannot be set if 4-02 Bypass/Operate is set to Bypass. In such case, the error message  

In Bypass, it doesn't operate appears. 

(*2) Events cannot be loaded or saved if Auto Event Load is set t o Enable. If UFM-30DCC is powered 
off and on again while Auto Event Load is set to Enable, priority is given to Auto Event Load 
over Start Up Event Load. If Auto Event Load is set to Enable, Start Up Event Load cannot be 
changed and an error message Auto Event Load Enable! appears. 

 

 STATUS Menu 
 Menu Refer 

to No. Item (full name) Short description 

7  System Status SYSTMSTS 5-2-8 

 7-02 SDI IN1 Format> IN1 STS>  

 7-03 SDI IN2 Format> IN2 STS>  

8  Module Information MDL INFO 5-2-9 

 8-01 Slot Number> Slot NO>  

 8-02 External Control Mode> CTL Mod>  

 8-03 Version Info> Version>  

 8-04 FPGA Version Info> FPGA>  

 8-05 UFM-3DCC2C Option Info> Dual Ch>  

 8-06 UFM-3DCCMF Option Info> Multi>  

 8-07 UFM-3DCC3G Option Info> 3G Op>  
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5-1-2-4. Link Mode Menu 

Two channels in Link mode share the same set of color corrector settings. Note that if 
some items are changed in Link mode, they are also changed in Single Channel mode 
and in "Setting1" of Dual Channel mode. 

 
 
 
 
 
 
 
 
 

Category Description 

Video Process AMP Allows you to set the Proc Amp function. 

Color Correction Allows you to set the Color Correction function. 

Video Clip Allows you to set the Video Clip function. 

SYSTEM Allows you to set system settings such as input signal selection. 

UTILITY Allows you to save and load events and adjust front panel settings. 

STATUS Displays video signal status and module information. 
 

Items in the VIDEO menu are the same in all operation modes. See "5-1-1. "1-Channel 
Color Corrector System" for the menu details. 

 SYSTEM Menu 
Menu Refer 

to No. Item (full name) Short description

4  System Setting System 5-2-5 

 4-02 Bypass/Operate> By-Op>  

 4-03 Loss Mode> LossMOD>  

 4-04 Back Color> BColor>  

 4-05 H Ancillary Mode> H ANCI>  

 4-06 V Ancillary Mode> V ANCI>  

 4-08 Output Delay 1>  Out DL1>  

 4-09 Output Delay 2>  Out DL2>  

 4-10 Test Signal Test SIG  

 4-11 Operation Mode> OP Mode>  

 UTILITY Menu 
 Menu Refer 

to No. Item (full name) Short description

5  Event Memory EventMEM 5-2-6 

 5-01 Start Up Event Load> (*1)(*2) STUP EL>  

 5-02 Auto Event Load> (*1)(*2) Auto EL>  

 5-03 Event Load> (*1)(*2) Ev Load>  

 5-04 Event Save> (*1)(*2) Ev Save>  

6  Front Panel Setting PanelSET 5-2-7 

 6-01 Front Brightness> Bright>  

 6-02 Panel Lock> Lock>  
(*1) This item cannot be set if 4-02 Bypass/Operate is set to Bypass. In such case, the error  message  

In Bypass, it doesn't operate appears. 

(*2)  When 4-11 Operation Mode is set to Link, VID FRMT does not appear in the menu and Auto 
Event Load cannot be set. If you select Auto Event Load, an error message In Link Mode, it 
doesn't operate appears. 

UFM-30DCC

Color Corrector 2
Setting 1 

Color Corrector 1
Setting 1 In1 

In2 

Out 1 

Out 2 
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 STATUS Menu 
Menu Refer 

to No. Item (full name) Short description 

7  System Status SYSTMSTS 5-2-8 

 7-02 SDI IN1 Format> IN1 STS>  

 7-03 SDI IN2 Format> IN2 STS>  

8  Module Information MDL INFO 5-2-9 

 8-01 Slot Number> Slot NO>  

 8-02 External Control Mode> CTL Mod>  

 8-03 Version Info> Version>  

 8-04 FPGA Version Info> FPGA>  

 8-05 UFM-3DCC2C Option Info> Dual Ch>  

 8-06 UFM-3DCCMF Option Info> Multi>  

 8-07 UFM-3DCC3G Option Info> 3G Op>  
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5-2. Menu Details (UFM-30DCC Front Panel) 

5-2-1. Color Corrector (Channel) Selection 

 In Dual Channel mode the following menu for selecting a color corrector appears. 
 

Menu Item Default Setting Description 

Select Color Corrector 1 or 2> Correct1 Correct1, 
Correct2 

Allows you to select a color 
corrector (channel). 

 
 

5-2-2. Video Process Amp 

The menu items for Proc Amp are the same in all operation modes. The items displayed in 
the Proc Amp menu vary depending on the 2-02 Correction Mode setting. 
 

No. 
Correction 

Mode 
setting 

Item Default Setting Range 
(Steps) Description 

1 Video Process AMP 

1-01 DIF, BAL, 
SEPIA Video Level> 100.0% 0.0 to 200.0% 

(0.1%) 
Allows you to adjust the 
video level. 

1-02 DIF, BAL, 
SEPIA Y Level> 100.0% 0.0 to 200.0% 

(0.1%) 
Allows you to adjust the 
luminance level. 

1-03 DIF, BAL Chroma Level> 100.0% 0.0 to 200.0% 
(0.1%) 

Allows you to adjust the 
chroma level. (*1) 

1-04 DIF, BAL, 
SEPIA Setup/Black Level> 0.0% -7.0 to 25.0% 

(0.1%) 
Allows you to adjust the 
black level. 

1-05 DIF, BAL Hue> 0.0° -180.0 to 180.0° 
(0.1°) 

Allows you to adjust hue. 
(*1) 

(*1)  Chroma Level and Hue cannot be set when 2-02 Correction Mode is set to SEPIA. In such case, the 
error  message   In Sepia mode, it doesn't operate appears. 

 
 

5-2-3. Color Correction 

The menu items for Color Correction are the same in all operation modes. The items 
displayed in the Color Correction menu vary depending on the 2-02 Correction Mode 
setting. 
 

No. 
Correction 

Mode 
setting 

Item Default 
Setting 
Range 
(Steps) 

Description 

2 Color Correction 

2-01 DIF, BAL, 
SEPIA Split Mode> Mode Off Mode Off,

Mode1 to 3

Allows you to set split screen 
mode for comparing images 
before and after a correction. 

Off: Displays the image after 
correction. 

Mode1: Splits the screen into two 
columns and displays the images 
before and after a correction. 

Mode2: Splits the screen into two 
rows and displays the images 
before and after a correction. 

Mode3: Displays the image 
before correction. 
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2-02 -- Correction 
Mode> BALANCE

BALANCE,
DIF, 
SEPIA 

Selects a correction mode from 
Balanced (RGB), Differential 
(YPbPr), or Sepia. 

BALANCE: RGB signal 
correction mode  
Allows you to adjust the white 
balance. Gray scale can be 
changed by adjusting R, G and 
B levels. 

DIFFERENTIAL: Color difference 
signal mode 
Allows you to adjust contrast 
without changing white 
balance. R, G and B levels can 
be changed without affecting 
gray scale. This adjustment is 
effective for images with 
different color saturation 
levels.  

SEPIA: Sepia mode 
Useful for creating black and 
white images. 

2-03 DIF, BAL Group 
Adjustment> Off Off, 

On 

Allows you to set whether R, G, 
and B are set at the same time or 
separately. (*1) 

Off: R, G, and B are set 
separately. 

On: R, G, and B are set at the 
same time. 

2-04 DIF, BAL White Level 
Red> 

0.0% 
0.0 to 

200.0% 
(0.1%) 

Allows you to set the white level. 
(*2) 2-05 DIF, BAL White Level 

Green> 

2-06 DIF, BAL White Level 
Blue> 

2-07 DIF, BAL Black Level 
Red> 

0.0% 
0.0 to 

200.0% 
(0.1%) 

Allows you to set the black level. 
(*2) 2-08 DIF, BAL Black Level 

Green> 

2-09 DIF, BAL Black Level 
Blue> 

2-10 DIF, BAL, 
SEPIA 

Gamma 
Curve> Center 

Center, 
Black, 
White 

Allows you to select the center of 
the gamma curve. 

Center: Gamma curve is 
weighted toward mid tones (near 
50%) 

Black: Gamma curve is weighted 
toward shadows (near 25%) 

White: Gamma curve is weighted 
toward highlights (near 75%). 

2-11 DIF, BAL Gamma Level 
Red> 

0.0% 
0.0 to 

200.0% 
(0.1%) 

Allows you to set the gamma 
level. (*3) 2-12 DIF, BAL, 

SEPIA 
Gamma Level 
Green> 

2-13 DIF, BAL Gamma Level 
Blue> 

2-14 SEPIA Sepia Level> 25.0% 
0.0 to 

100.0% 
(0.1%) 

Allows you to set the level for 
Sepia mode. (*4) 

2-15 SEPIA Sepia Color> -160.0° 
-180.0 to 
180.0° 
(0.1°) 

Allows you to select a color for 
Sepia mode. (*4) 
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(*1) Group Adjustment is not available regardless of this setting when controlling via web browser. 

(*2) In Sepia mode, White Level Red / Green / Blue and Black Level Red / Green / Blue are not 
available. If these items are selected, an error message In Sepia mode, it doesn't operate appears.

(*3) In Sepia mode, only the Y signal can be set at Gamma Level Green. Other gamma levels cannot be 
set and if they are selected, an error message In Sepia mode, it doesn't operate appears. 

(*4) Sepia Level and Sepia Color are not available in BALANCE or DIF mode. In such case, the error  
message In BAL Mode, it doesn't operate or In DIF Mode, it doesn't operate appears. 

 
 

5-2-4. Clip Control 

The menu items for Clip Control are the same in all operation modes. The items displayed in 
the Clip Control menu vary depending on the 3-01 Video Clip Mode setting. 
 

No. 
Video Clip 

Mode 
setting 

Item Default Setting Range
(Steps) Description 

3 Video Clip 

3-01 --- Video Clip Mode> Off 

Off, 
YPbPr, 
GBR, 
VBS 

Allows you to select Video 
Clip mode. 

Off: Disables Video Clip mode.

YPbPr: YPbPr color space.
GBR: GBR color space 
VBS: composite color 
space. 

3-02 YPbPr Y White Clip> 109.0% 50.0 to 109.0%
(0.1%) 

Sets the Y signal upper 
threshold. (*1) 

3-03 YPbPr Y Black Clip> -7.0% -7.0 to 50.0% 
(0.1%) 

Sets the Y signal lower 
threshold. (*1) 

3-04 YPbPr Chroma Clip> 113.0% 50.0 to 113.0%
(0.1%) 

Sets the C signal upper 
threshold. (*1) 

3-05 GBR GBR White Clip> 300.0% 50.0 to 300.0%
(0.1%) 

Sets the GBR color space 
upper threshold. (*2) 

3-06 GBR GBR Black Clip> -200.0% -200.0 to 50.0%
(0.1%) 

Sets the GBR color space 
lower threshold. (*2) 

3-07 VBS Composite White 
Clip> 150.0% 50.0 to 150.0%

(0.1%) 

Sets the VBS (composite) 
color space upper threshold. 
(*3) 

3-08 VBS Composite Black 
Clip> -50.0%

-50.0 to 50.0%

(0.1%) 

Sets the VBS (composite) 
color space lower threshold.  
(*3) 

(*1) See "YPbPr Clip Adjustment" (p28). 
This item is not available when 3-01 Video Clip Mode is set to Off, GBR or VBS. In such case, the 
error  message "In Clip Off, it doesn't operate, In GBR Clip, it doesn't operate or In VBS Clip, it doesn't 
operate" appears. 

(*2) See "GBR Clip Adjustment" (p29). 
This item is not available when 3-01 Video Clip Mode is set to Off, YPbPr or VBS. In such case, the 
error  message "In Clip Off, it doesn't operate", "In YPbPr Clip, it doesn't operate" or "In VBS Clip, it 
doesn't operate" appears. 

(*3) See Composite Clip Adjustment" (p29). 
This item is not available when 3-01 Video Clip Mode is set to Off, YPbPr or GBR . In such case, the 
error  message "In Clip Off, it doesn't operate"," In YPbPr Clip, it doesn't operate" or "In GBR Clip, it 
doesn't operate" appears. 
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 YPbPr Clip Adjustment 
 

Y White Clip Level 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Y Black Clip Level 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

C White Clip Level 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SMPTE 100% color bars when 100% white

109%
100%

50%

 50% 

0%

Y White Clip 
setting range 

SMPTE 100% color bars when 100% black

100%

50%

0%

50% 

-7%

Y Black Clip 
setting range 

50% 

50% 

0%

50%

100%

113%

SMPTE 100% color bars when color 700 mVp-p

C White Clip 
setting range 



29 

 GBR Clip Adjustment 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Composite Clip Adjustment 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

300% 
White Clip default value 

100% 

-200% 
Black Clip default value

0% 

50% 

GBR Clip

Black Clip 
setting range 

White Clip 
setting range 

150% 

100% 

0% 

-50% 

50% 

Composite (VBS) Clip

White Clip default value 

Black Clip default value

Black Clip 
setting range 

White Clip 
setting range 
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5-2-5. System Setting 

The System menu items vary depending on the operation mode. 
 

Menu 
Default Setting 

Range Description 
No. Mode Item 

4 System Setup 

4-01 Single Input Select> SDI In1 SDI In1, 
SDI In2 

Allows you to select an input 
channel. 

4-02 
Single 
Dual 
Link 

Bypass/Operate> Operate Operate, 
Bypass 

If set to Bypass, the input signal 
is output from UFM-30DCC 
without processing.(*1) 

4-03 
Single 
Dual 
Link 

Loss Mode> Back 
COL 

BackCOL,
ColorBar, 
Disable 

Allows you to specify the action 
to be taken when no signal is 
present. 

4-04 
Single 
Dual 
Link 

Back Color> Black 
Black, 
Gray, 
Blue 

Allows you to select a 
background color when no signal 
is present. 

4-05 
Single 
Dual 
Link 

H Ancillary Mode> Through Through, 
Delete Through: Passes through 

ancillary data without processing.

Delete: Deletes all ancillary data.4-06 
Single 
Dual 
Link 

V Ancillary Mode> Through Through, 
Delete 

4-07 Single 
Dual Output Delay> --- (*2) 

Allows you to set the output delay 
in the range from minimum delay 
to approx. 1H. The setting range 
varies depending on the format. 

The setting automatically returns 
to the minimum delay when the 
input signal format is changed. 
(See the table below) 

4-08 Link Output Delay1> --- (*2) 

Allows you to set the output delay 
for Out1 in the range from 
minimum delay to approx. 1H. 
The setting range varies 
depending on the format.  

The setting automatically returns 
to the minimum delay when the 
input signal format is changed.  

4-09 Link Output Delay2> --- (*2) 

Allows you to set the output delay 
for Out2 in the range from 
minimum delay to approx. 1H. 
The setting range varies 
depending on the format.  

The setting automatically returns 
to the minimum delay when the 
input signal format is changed.  

4-10 
Single 
Dual 
Link 

Test Signal> Off 

Off, 
Full CB, 

SMPTE CB,
RAMP 

Allows you to output a test signal. 
The test signal appears in full 
screen regardless of the VIDEO 
menu setting. 

4-11 
Single 
Dual 
Link 

Operation Mode > Dual 
Single, 
Dual, 
Link 

Allows you to select an operation 
mode for UFM-30DCC. (*3) 

Single: Single Channel mode 
Dual: Dual Channel mode 
Link: Link mode 

 
(*1) Bypass mode 

In Bypass mode, the items shown in the table in the next page are not available. In such case, 
the error message In Bypass, it doesn't operate appears. 
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Item Reference 

Select Color Corrector 1 or 2 5-2-1. Color Corrector (Channel) Selection 

System Setting 5-2-5. System Setting 

Front Panel Setting 5-2-7. Front Panel Setting 

System Status 5-2-8. System Status 

Module Information 5-2-9. Module Information 
 

(*2) Setting Range for Output Delay 
System Format Output Delay setting range 

525/60 200CLK to 1716CLK 

1080/59.94i 140CLK to 2200CLK 

720/59.94p 140CLK to 1650CLK 

625/50 200CLK to 1728CLK 

1080/50i 140CLK to 2640CLK 

720/50p 140CLK to 1980CLK 
 

(*3) Operation Mode 
Operation Mode is not displayed in the 1-Channel system. In the 2-Channel system (option 
installed), it is displayed in all operation modes including Single Channel mode. 
Single Channel mode, Link mode and "Setting1" of Dual Channel mode share the same 
set of color corrector settings. Therefore, if some items are changed before switching the 
operation mode, the same changes are applied in the new operation mode. If you wish to use 
specific settings in each mode, save them to and load them from an event memory.  
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5-2-6. Event memory 

Menu 
Default Setting 

Range Description 
No. Item 

6 Event Memory 

6-01 
Start Up Event 
Load >  
(*1)(*2)(*3) 

Last Set

Last Set, 
VID FRMT,

Default, 
Event 1 to 50

Allows you to select an event to load 
when booted. 

Last Set: Loads the last settings 
before boot-up. (*3) 

VID FRMT: Detects the last video input 
format before booting and loads default 
settings used for the video format. 

Default: Loads the default settings. 

Event 1-50: Loads the settings saved 
to Event 1-50. 

6-02 Auto Event Load > 
(*1)(*3) Disable Disable, 

Enable 
Enable: Automatically loads default 
settings used for each video format.. 

6-03 Event Load >  
(*1)(*3)(*4) - 

Default,  
VID FRMT,

Event 1 to 50

Default: Resets to default settings. 

VID FRMT: Loads default settings  
used for each video format. 

Event 1-50: Loads the settings 
selected from Event 1-50. 

Press the UNITY button to load the 
selected event. (*6) 

6-04 Event Save > 
(*1)(*3)(*5) - 

VID FRMT,
 Event 1 to 

50 

VID FRMT: Saves the current settings 
as default settings for the video format.

Event 1-50: Saves the settings to 
Event 1 to 50. 

Press the UNITY button to save the 
selected event. (*6) 

(*1) Events cannot be loaded or saved if Auto Event Load is set to Enable. If UFM-30DCC 
is powered off and on again while Auto Event Load is set to Enable, priority is given to Auto 
Event Load over Start Up Event Load. If Auto Event Load is set to Enable, Start Up 
Event Load cannot be changed and the error message Auto Event Load Enable! appears. 
 
(*2) If the data loaded at startup by the Start Up Event Load and the last detected video 
signal format at power-off are different, 4-07 Output Delay, 4-08 Output Delay1 and 4-09 
Output Delay2 are reset to default based on the video format of the current input. 
 
(*3) In Link mode, VID FRMT is not displayed and Auto Event Load cannot be changed. If 
you select Auto Event Load, the error message In Link Mode, it doesn't operate appears. 
 
If the operation mode is changed to Link and the following items were set to VID FRMT or 
Enable in the previous mode, these values are automatically changed as shown in the table 
below in Link mode. 

Menu item Previous setting Setting in Link mode 

5-01 Start Up Event Load VID FRMT Last Set 

5-02 Auto Event Load Enable Disable 

5-03 Event Load VID FRMT Default 

5-04 Event Save VID FRMT Event1 
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(*4) 4-07 Output Delay, 4-08 Output Delay1 and 4-09 Output Delay2 are set as shown 
below when loading events. 

 When the signal format of the current input is the same as that in the loaded event: 
The data in the event is loaded (See the example in the table below.) 
 Input signal format Output Delay value 

Format selection saved in the loaded event 1080/59.94i 230CLK 

Current format (input video format when 
loading an event) 

1080/59.94i 230CLK 

 When the signal format of the current input is not the same as that in the loaded 
event, but Output Delay is within the default setting of the current format: 
The data in the event is loaded (See the example in the table below.) 
 Input signal format Output Delay setting 

Format selection saved in the loaded event 1080/59.94i 230CLK 

Current format (input video format when 
loading an event) 

525/60 230CLK 

 When the signal format of the current input is not the same as that in the loaded 
event and Output Delay is not within the default setting of the current format: 
The minimum or maximum value of the setting range of Output Delay for the current 
format is set. (See the examples below.) 

 

Example1) If Output Delay is within the default setting of the current format: 
 Input signal format Output Delay setting 

Format selection saved in the loaded event 1080/59.94i 150CLK 

Current format (input video format when 
loading an event) 

525/60 200CLK (minimum 
setting range value) 

 

Example2) Output Delay is not within the default setting of the current format 
 Input signal format Output Delay setting 

Format selection saved in the loaded event 1080/59.94i 2000CLK 

Current format (input video format when 
loading an event) 

525/60 1716CLK (maximum 
setting range value) 

 

(*5) The items in the table below are not saved to events. 
Item Reference 

Select Color Corrector 1 or 2 5-2-1. Color Corrector (Channel) Selection 

Group Adjustment 5-2-3. Color Correction 

Operation Mode 5-2-5. System Setting 

Front Panel Setting 5-2-7. Front Panel Setting 

System Status 5-2-8. System Status 

Module Information 5-2-9. Module Information 
 

(*6) All operation modes share Event1 to 50. 
 

The factory default settings are saved in Event1 to 50 and VID FRMT at shipment from the 
factory. 

 

NOTE

About automatic saving 

The UFM-30DCC automatically saves the last settings. After changing settings, wait at 
least 3 seconds before powering off. Otherwise, the settings may not be saved. 
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5-2-6-1. About VID FRMT (VIDEO FORMAT) Event Memory 

On the UFM-30DCC, an event memory is provided for each video input format, and the 
default settings used for each format can automatically be loaded when the video input 
format is changed. 
 
Saving Settings for a Specific Video Format (525/60 in the example below) 
1. Input a 525/60 signal to the SDI1 connector on the UFM-30DCC. 
2. Check if Input Select is set to 1. 
3. Change the settings as required. 
4. Check if Auto Event Load is set to Disable. 
5. Select VID FRMT in Event Save. Press the UNITY button to save the settings to the 

event memory provided for 525/60. 
 
*To save settings for other formats such as 625/50, 1080/59.94i, 1080/50i, 720/59.94p, 
and 720/50p, input the signal to SDI1 and repeat steps 1 to 5. 
 
*Input Select described in step 2 can also be set to 2. In such case, input the signal to 
SDI2. 
 
Manually loading an Event for a Specific Video Format 
1. Input a signal with a format whose default settings are already saved in the event 

memory, to UFM-30DCC. 
2. Check if Auto Event Load is set to Disable. 
3. Select VID FRMT in Event Load. Press the UNITY button to load the event of the 

specified format. 
 

NOTE

In Link mode, VID FRMT is not displayed and Auto Event Load cannot be changed. 
If you select Auto Event Load, an error message In Link Mode, it doesn't operate 
appears. 
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5-2-7. Front Panel Setting 

Menu 
Default Setting 

Range Description 
No. Mode Item 

6 Front Panel Setting 

6-01 
Single 
Dual 
Link 

Front 
Brightness> 50% 

25%, 
50%, 
75%, 
100% 

Allows you to select the brightness of the 
front panel display. 

6-02 
Single 
Dual 
Link 

Panel Lock> Operate Operate,
Lock 

Setting to Lock inhibits front panel 
operation. Hold down the Push switch 
for about 2 seconds to release (Operate) 
Panel Lock. 

6-03 Dual Input Status 
Display Set> 1min 

Off, 
1min, 
5min 

Allows you to set the time until the input 
signal status is automatically displayed 
while no operations are being 
performed.  

Off: No display 
1min: Displays the input status when no 
operation is performed within 1 minute.
5min: Displays the input status when no 
operation is performed within 5 minutes.

 

5-2-8. System Status (Display Only) 

Menu 
Description 

No. Mode Item 

8 System Status 

8-01 Single Selected SDI Input> Displays the currently selected input signal. 

8-02 
Single 
Dual 
Link 

SDI IN1 Format> Displays the video signal format input to SDI IN1. 

8-03 
Single 
Dual 
Link 

SDI IN2 Format> Displays the video signal format input to SDI IN2. 

 

5-2-9. Module Information (Display Only) 

Menu 
Description 

No. Item 

9 Module Information 

9-01 Slot Number> Displays the slot number where the module is installed.

9-02 External Control Mode> Displays the current external control mode. "MD Mode" 
is displayed while controlling via a web browser. 

9-03 Version Info> Displays the firmware version. 

9-04 FPGA Version Info> Displays the FPGA version. 

9-05 
UFM-3DCC2C Option Info> Displays the dual channel option status. 

Install: The dual channel option is installed. 
None: The dual channel option is not installed. 

9-06 

UFM-3DCCMF Option Info> Displays the multi-format option status. 

Install: The multi-format option is installed. 
None: The multi-format option is not installed. 

* "Install" is shown when a 3G-SDI option is installed. 

9-07 
UFM-3DCC3G Option Info> Displays the 3G-SDI option status. 

Install: The 3G-SDI option is installed. 
None: The 3G-SDI option is not installed. 
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6. Internal Settings 

6-1. Dipswitch S3 
Dipswitch S3 on the FRONT CARD allows you to select the control method between DCC-OUA 
or Web, select a process mode between Legacy or 30DCC, and re-initialize the UFM-30DCC. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Dipswitch S3 setting 

Pin No. Function 
Setting Factory default 

Setting OFF ON 

1 Select DCC-OUA or Web controller  OUA WEB OFF 

2 FACTORY SET - - OFF 

3 Select a process mode Legacy 30DCC ON 

4 FACTORY SET - - OFF 

5 FACTORY SET - - OFF 

6 Initialization OFF ON OFF 

7 FACTORY SET - - OFF 

8 FACTORY SET - - OFF 

 
 

6-1-1. Select DCC-OUA or Web controller (S3-1) 

To control the UFM-30DCC via a web browser, set S3-1 to ON. 
OFF (default) Allows you to control the UFM-30DCC with DCC-OUA 

ON Allows you to control the UFM-30DCC via a web browser and/or 
DCC-NETOU. (*1) (*2) 

(*1) Jumper settings are also necessary. (See section 6-2. “Jumper Settings.”) 
(*2) A UFM-30CTL Control Card (available for separate purchase) is necessary. 
 
 

6-1-2. Initialization (S3-6) 

1) Change dipswitch S3-6 on the FRONT CARD to ON. 
2) Turn Off then On the UFM frame into which the UFM-30DCC is installed. The initialization 

is complete when Complete is displayed. All settings for UFM-30DCC return to the 
factory default settings. 

3) Return S3-6 to OFF. 
 

IMPORTANT

Do not change any pin settings other than those described above. 

 

FRONT CARD REAR CARD 

S3 

8 

 ON 

1 
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6-1-3. Select UFM-30DCC or Legacy Mode (S3-3) 

Select a process mode between the following two options. 

OFF 
The UFM-30DCC performs color correction and then Proc Amp 
adjustments. This is the same as in DCC-70HS, DCC-100 and 
UFM-100DCC (Legacy mode). 

ON (default) The UFM-30DCC performs Proc Amp adjustments and then color 
correction. 

 

 UFM-30DCC Flow Diagram 
If in UFM-30DCC mode (S3-3: ON): 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If in DCC legacy mode (S3-3: OFF): 
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6-2. Jumper JP3 
 

IMPORTANT

Do not change the JP1 jumper setting on the REAR CARD of UFM-30DCC from the 
factory default settings. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Factory Default Settings for JP1 and JP3 
JP No. Factory Default Setting 

JP1 2-3 short 

JP3 

1-2 short 

4-5 short 

7-8 short 

10-11 short 

*Do not change the JP1 jumper setting. 
 
 

6-2-1. Select DCC-OUA or Web Control 

The JP3 setting determines the UFM-30DCC control method between DCC-OUA and the 
Web browser. The dipswitch S3-1 setting is also necessary. (See section 6-1. “Dipswitch 
S3.”) 
 

DCC-OUA 
controller 

 

 

 

 

Web controller 
(*1) 

 

 

 

 
(*1) A UFM-30CTL Control Card (available for separate purchase) is necessary. 

JP3 

12

3

10

1

FRONT CARD REAR CARD 

Factory settings 

JP3 

12 
 

3 

10 
 

1 

JP1 

1 3

JP3 

12

3

10

1

1-2 short 
4-5 short 
7-8 short 
10-11 short 

2-3 short 
5-6 short 
8-9 short 
11-12 short 



39 

7. Troubleshooting 
If any of the following problems occur during the operation of your UFM-30DCC, proceed as 
indicated below to see if the problem can be corrected before assuming a unit malfunction has 
occurred. 
 

Problem Check Action 

Cannot operate 
UFM-30DCC from the 
front panel. 

Is Lock displayed in the 
menu display? 

Press and hold down the menu control 
button on the front panel to release the 
panel lock. (See 4-2-2 or 5-2-7.) 

Cannot adjust color 
correction settings. The Bypass/Operate 

setting 
Set Bypass/Operate to Operate. (See 
"DCC-OUA Operation Manual" or 5-2-5.) Cannot adjust video 

clip settings. 

Cannot set Chroma 
Level. The Correction Mode 

setting 
Set Correction Mode to BALANCE or 
DIF. 

Cannot set Hue. 

Cannot operate 
UFM-30DCC from 
Web browser. 

Is the web browser 
properly connected to 
UFM-30CTL? 

See "UFM-30CTL Operation Manual" to 
verify the connection.  

The dipswitch S3-1 
setting Set S3-1 to ON. (See 6-1-1.) 

The jumper JP3 setting Set JP3 for (See 6-2-1.) the WEB control 
setting. 

Some functions such 
as split or gamma 
curve cannot be 
adjusted from the 
remote control unit. 

Are you operating 
UFM-30DCC with 
DCC-OU? 

DCC-OU cannot control some functions of 
UFM-30DCC. (See 3-1-2.) Use a 
DCC-OUA for full control of the 
UFM-30DCC. 

Cannot operate 
UFM-30DCC from 
DCC-OUA. 

Is DCC-OUA properly 
connected to 
UFM-30CTL? 

Plug the supplied cable to the REMOTE 
connector on the UFM-30DCC and plug 
the other end of the cable to DCC-OUA. 

The dipswitch S3-1 
setting Set S3-1 to OFF. (See 6-1-1.) 

The jumper JP3 setting Set JP3 for (See 6-2-1.) the DCC-OUA 
control setting. 

Some setting values 
are changed 
unintentionally after 
the operation mode is 
changed. 

Were these values 
changed in the previous 
operation mode? 

Note that the same set of values is applied 
to Single Channel mode, Link mode and 
"Setting1" in Dual Channel. Therefore, if 
some values are changed, The same 
changes are applied to other modes. 

Cannot save/load 
events. 

The Auto Event Load 
setting 

Set Auto Event Load to Disable. (See 
5-2-6.) 

Cannot set Auto 
Event Load. 

The Operation Mode 
setting 

Auto Event Load cannot be changed in 
Link mode. 

The Output Delay 
setting is reset after 
loading an event. 

The input video format 
saved in the event and 
the input video format 
when the event is 
loaded. 

If these formats are different, the Output 
Delay is reset in some cases. (See 5-2-6.)

The Output Delay 
setting is reset at 
startup, though Start 
Up Event Load has 
been set to Last Set. 

The input video format 
when powered off and 
the current input format. 

If these formats are different, the Output 
Delay is reset. (See 5-2-6.) 
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8. Specifications and Dimensions 

8-1. Unit Specifications 

Video Format 1080/59.94i, 50i, 720/59.94p, 50p 
525/60, 625/50 

Video Format  
(if 
UFM-3DCC3G 
installed:) 

1080/50p, 59p, 60p (Level A)  
1080/60i, 1035/59.94i, 60i 
1080/30PsF, 23.98PsF,24PsF,25PsF,29.97PsF 
1080/30p, 23.98p, 24p, 25p, 29.97p 
720/23.98p, 24p, 25p, 30p, 29.97p, 60p 
(1080/30PsF, /29.97PsF, /25PsF signals are processed as 1080/60i, 59.94i, 
50i respectively.)  

Video Input 3G-SDI: 3 Gbps, HD-SDI: 1.5 Gbps, or SD-SDI: 270 Mbps 75Ω BNC x 2 

Video Output 3G-SDI: 3 Gbps, HD-SDI: 1.5 Gbps, or SD-SDI: 270 Mbps 75Ω BNC x 2 

Controller DCC-OUA (Ver. 3.00 or higher) 
WEB-based control/ SNMP monitoring (UFM-30CTL required)  
DCC-NETOU (UFM-30CTL required)  
* DCC-OUA cannot be used with other controllers at the same time.  

Signal 
Processing 

4:2:2 digital component 

Quantization Y: 10-bit, C: 10-bit 

Sampling 
Frequency 

3G-SDI: Y: 148 MHz, C: 74 MHz  
HD-SDI: Y: 74 MHz, C: 37 MHz  
SD-SDI: Y: 13.5 MHz, C: 6.75 MHz 

Internal 
Processing 

1-Channel system: 1-channel with 2-output, input selectable 
2-Channel system: 2-channel, 2-input, 2-output (option) 

I/O Delay Settable from 200 CLK (SD) /140 CLK (HD) (minimum)  
to approx. 1 H (maximum) 

Video function Process Amp, Video clip, Video freeze 

Process Amp Video level: 0.0% to 200.0% 
Y level: 0.0% to 200.0% 
Chroma level: 0.0% to 200.0% 
Setup / black level: -7.0% to 25.0% 
Hue: -180.0° to +180.0° 

Color Correction Mode: Balance, Differential and Sepia 

 Balance and Differential mode: 

-White level (RGB): 0.0% to 200.0% (against input) 
-Black level (RGB): 0.0% to 200.0% (against input) 
-Gamma level (RGB): 0.0% to 200.0% (against input) 
-Gamma curve: WHITE, CENTER or BLACK 

 Sepia mode: 

-Sepia level: 0.0% to 100.0% 
-Sepia color: -180.0° to +180.0° 

Video Clip Mode: YBR clip, GBR clip and Composite clip 

 YBR clip 

-Y LEVEL clip: 50.0% to 109.0% 
-BLACK clip: -7.0% to 50.0% 
-C LEVEL clip: 50.0% to 113.0% 

 GBR clip 

-WHITE clip: 50.0% to 300.0% 
-BLACK clip: -200.0% to 50.0% 

 Composite clip 

-White clip: 50.0% to 150.0% 
-BLACK clip: -50.0% to 50.0% 
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Processing 
order 
(internal setting) 

UFM-30DCC processing mode: Process Amp first, and then to Color 
Correction 

Legacy processing mode: Color Correction first, and then to Process Amp 

Split mode Display mode selectable from 4 types. 

Ancillary data Pass or through selectable for H and V ancillary packets. 

Interface REMOTE (RS-422): 9-pin D-sub (female) x 1 (with inch screws) (for 
DCC-OUA connection) 

Temperature 0°C to 40°C 

Humidity 30% to 85% (no condensation) 

Power +24 VDC (supplied from UFM frame) 

Consumption Approx. 0.8 A 

Dimensions  Front module: 106 (W) x 293.2 (D) (mm) 
Rear modeul: 108.5 (W) x 105.3 (D) x 20 (H) (mm) 

Weight Approx. 0.5 kg 

Consumables None 

Option UFM-3DCC3G: 3G-SDI option 

 UFM-3DCC2C: Dual channel option 

 DCC-OUA: Operation Unit for Color Corrector 

 DCC-NETOU: Network Operation Unit for Color Corrector 

 UFM-30CTL: Control Card 

 Control Cable: For DCC-OUA connection (PC-2076-3, 10 m) 
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8-2. External Dimensions 

(All dimensions in mm) 
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Warning 
 
This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to Part 15 of FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference, in 
which case the user will be required to correct the interference at his own 
expense. 
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